Monitoring Video Using the Cisco Video Surveillance Operations Manager, Release 7.2

The Cisco VSM Operations Manager is a browser-based configuration and administration tool that can also be used to monitor live and recorded video.

This document describes the features and options of the Monitor tab, which is the default window when you log in to the Operations Manager. Refer to the following topics for more information.

Contents

- Logging In and Changing Your Password, page 2
- Operations Manager Requirements, page 3
- Using the Monitor Video Page, page 3
- Selecting a Multi-Pane “View”, page 4
- Controlling Live and Recorded Video, page 7
  - Overview, page 8
  - Viewing Live Video, page 9
  - Viewing Recorded Video, page 12
  - Creating, Viewing and Managing Video Clips, page 17
  - Using Record Now, page 24
  - Using the Pop-Up Menu, page 25
  - Understanding Video Pane Border Colors, page 27
  - Synchronizing Video Playback in Multiple Panes, page 29
  - Using Pan, Tilt, and Zoom (PTZ) Controls, page 32
- Viewing a Thumbnail Summary of Video Archives, page 39
  - Using Thumbnail Search, page 41
- Understanding the Additional Video Viewing Options, page 44
Logging In and Changing Your Password

- Logging In, page 2
- Changing Your Password, page 2

Logging In

To log in to the Cisco Video Surveillance Operations Manager:

**Step 1** Launch the 32-bit or 64-bit version of Internet Explorer on your Windows computer. See the “Operations Manager Requirements” section on page 3 for more information.

**Step 2** Enter the Operations Manager URL or IP address.

**Step 3** Enter your username and password.

**Step 4** Select a Domain:
- Choose the default “localhost” if your account was created using the Operations Manager.
- Select an alternative domain if instructed by your system administrator.

**Step 5** Enter a new password, if prompted.

You must enter a new password the first time you log in, or when your password periodically expires.

**Step 6** If prompted, complete the on-screen instructions to install or upgrade the Cisco Multi-Pane client software on your computer.
- This application is an Active X client that enables video playback and other features.
- Video will not play unless the Cisco Multi-Pane client software is correctly installed.
- If using the 64-bit version of Internet Explorer, you will be prompted to install the 64-bit version of the Cisco Multi-Pane client, if necessary.
- You must have administrative privileges on the PC workstation to install the software.
- You will also be prompted to install the required Microsoft .Net 4.0 component, if necessary. If your workstation does not have Internet access, the .Net 4.0 installer can be downloaded from http://www.microsoft.com/en-us/download/details.aspx?id=17718.

**Note** You must log in with a standard Windows 7 user account. Logging in with a Guest account can prevent video streaming and result in an error to be displayed in the video pane: “Cannot create RTSP connection to server. Check network connection and server health status.”

Changing Your Password

To change your password, click your username in the top right corner of the browser (Figure 1).

**Note** Users from external systems (LDAP servers) cannot change their password using the Cisco VSM Operations Manager.
If you forgot your password, contact your system administrator and ask them to create a new password (you will be prompted to change it when you log in).

**Step 1** Log in to the Operations Manager (see [Logging In](#)).
**Step 2** Click your username in the top right ([Figure 1](#)).
**Step 3** Enter your current password.
**Step 4** Enter and re-enter a new password.

![Figure 1 Changing Your Password](image)

### Operations Manager Requirements

See the Cisco Video Surveillance Monitoring Workstation Performance Baseline Specification for the complete performance specifications for a video surveillance monitoring workstation.

### Using the Monitor Video Page

Open the Monitor Video window to view video using the Cisco VSM Operations Manager.

#### Procedure

**Step 1** Log on to the Cisco VSM Operations Manager.

**Note** See the “Logging In” section on page 2. You must belong to a User Group with permissions for View Live Video or View Recordings.

**Step 2** If prompted, complete the on-screen instructions to install or upgrade the Cisco Multi-Pane client software on your computer.

**Note** This application is an Active X client that enables video playback and other features. Video will not play unless the Cisco Multi-Pane client software is correctly installed.
Step 3  
Click **Monitor Video**.

Step 4  
(Optional) Select **View Menu** to select a video grid of multiple cameras.
- **Select**—select a blank layout.
- **Select Views**—select a pre-defined **View**.

See the “Selecting a Multi-Pane “View”” section on page 4 for more information.

Step 5  
Expand the location tree and drag a camera from the list onto a viewing pane.

| Tip | Enter a partial or complete camera name in the **Find** field to display matching cameras.
| Tip | You can also select a video pane by clicking in it, and then double-click the camera name.

Step 6  
See the “Controlling Live and Recorded Video” section on page 7 to use the video playback controls.

**Selecting a Multi-Pane “View”**

To view video from more than one camera, select an option from the **View Menu**, as described in **Table 7**:

**Figure 2  Video Layouts**

![Video Layouts Diagram]
Tip

To change the video in a View pane, drag and drop a camera name onto the pane.

Views can be accessed using either the browser-based Operations Manager or the Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) application. The Operations Manager can display a maximum of 4 video panes using the 32-bit version of Internet Explorer, and up to 16 panes when using the 64-bit version. Cisco SASD can display up to 16 panes.

Double-click a video pane to fill the screen with that video (Figure 3). A preview of the other video panes is shown in a smaller grid at the bottom of the screen. Double-click the video pane again to return the grid to normal size.

Table 1  View Menu

<table>
<thead>
<tr>
<th>Menu</th>
<th>Purpose</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Layout</td>
<td>Blank layouts</td>
<td>Choose Select Layout to select a blank layout (Figure 2), and then select cameras for each pane.</td>
</tr>
<tr>
<td>Current View</td>
<td>Save or reset the currently</td>
<td>• Choose Current View &gt; Save As to save a layout or view under a new name. Enter a name and location for the view.</td>
</tr>
<tr>
<td></td>
<td>displayed layout</td>
<td>Tip Views can be assigned to the same location as the cameras, or to a higher level location. The new View appears under the Select View menu. Views are displayed in both the Operations Manager and Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) application.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Choose Current View &gt; Reset to reload the last view or layout and discard any changes.</td>
</tr>
<tr>
<td>Select View</td>
<td>Display pre-defined views</td>
<td>Choose Select View to select a pre-defined multi-pane view. Views can be configured to rotate video from multiple cameras to provide a virtual tour of a building or area. The video panes can (optionally) rotate video from different cameras to provide a virtual tour of a building or area.</td>
</tr>
<tr>
<td>Set Default View</td>
<td>Define the view that is</td>
<td>The Default View is defined by each user and is automatically loaded when you click Monitor Video.</td>
</tr>
<tr>
<td></td>
<td>automatically loaded</td>
<td>1. Create one or more Views.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Select View Menu &gt; Set Default View.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Select a View from the pop-up window and click Select.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note The Default View is saved as a cookie in the browser and is unique to each user/PC. The Default View is not displayed if using a different workstation.</td>
</tr>
</tbody>
</table>

OL-31738-01

Monitoring Video Using the Cisco Video Surveillance Operations Manager, Release 7.2
Selecting a Multi-Pane “View”

Figure 3    Enlarge a Video Pane
Controlling Live and Recorded Video

Each video viewing pane in a Cisco Video Surveillance monitoring application supports the following controls and features.

The features available on your workstation depend on the following:

- The camera and system configuration.
- Your user account access permissions.
- The features supported by the video monitoring application.

Contents
Refer to the following topics for more information.

- Overview, page 8
- Viewing Live Video, page 9
- Viewing Recorded Video, page 12
- Creating, Viewing and Managing Video Clips, page 17
- Using Record Now, page 24
- Using the Pop-Up Menu, page 25
- Understanding Video Pane Border Colors, page 27
- Using the Smooth Video Options When Viewing Live Video, page 27
- Synchronizing Video Playback in Multiple Panes, page 29
- Using Pan, Tilt, and Zoom (PTZ) Controls, page 32
Overview

To view live and recorded video, log on to the monitoring application and drag and drop camera names onto the available viewing panes (you can also select a pane and double-click the camera name). Use Views to view multiple panes in a single window.

For example, Figure 4 shows a multi-pane view using the Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) application.

Figure 4    Multi-Pane View using the Cisco Video Surveillance Safety and Security Desktop

Each viewing pane includes various controls that allow you to do the following:

- Switch between live and recorded video.
- Select the playback timespan.
- Pause, play, or skip forward and back.
- Create and save video clips from recorded video
- Mute or un-mute the audio (if available).
- Synchronize the playback of multiple recordings.
- Control the Pan Tilt and Zoom (PTZ) movements of a camera (if supported by the camera).
- Additional options are available by right-clicking the image. Options include synchronizing multiple viewing panes, recording live video, expanding the image to fill the screen, creating a snapshot image, and configuring smooth video options to improve playback performance when network performance is poor.
Controlling Live and Recorded Video

The available controls depend on the camera model and system configuration. For example, pan-tilt-zoom (PTZ) controls are available only on cameras that support PTZ. Recording options are available only if the camera is configured to record video. Synchronized playback is available for recorded video (not live video). See your system administrator for more information.

Viewing Live Video

Live video is displayed by default when you log in to the viewing application. Figure 5 summarizes the controls available in each viewing pane.

Note

To control the playback in multiple video panes, Shift-Click or Ctrl-Click to select the panes. The borders of all selected panes turn to orange. Controls and actions performed in one pane also affect the other selected panes. To deselect panes, select a single pane, or use Shift-Click or Ctrl-Click to deselect the panes.

Tip

- Live video may be delayed 1-2 seconds. Live video can be further delayed if the smooth video option is enabled. See the “Using the Smooth Video Options When Viewing Live Video” section on page 27 for more information.
- Soft-deleted cameras (shown with a icon) are cameras that were removed from the system but still allow access to the camera’s recorded video. You cannot display live video from soft-deleted cameras.
- The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change your monitor color setting to 32-bit.
Controlling Live and Recorded Video

**Figure 5  Video Pane Controls**

1. **Camera name**—The source of the displayed video.
2. Indicates the quality of the primary live video stream. If the live video quality is poor, an alternative secondary or iFrame video stream can be automatically applied. See the “Using the Smooth Video Options When Viewing Live Video” section on page 27 for more information.
3. Indicates live or recorded video (recorded video displays a time stamp such as 4/2/2012 1:203:56 PM).
4. Range Bar—Used with recorded video (see the “Viewing Recorded Video” section on page 12 for more information).
5. Seek—Used with recorded video to choose a playback time (see the “Viewing Recorded Video” section on page 12 for more information).
6. The green icon indicates live video. Click the icon to switch to the recorded view.
7. Live video playback controls.
   - —Pause the video playback.
   - —Play the video forward at normal speed.
   **Note** The other playback controls are used with archived video only. See Figure 6 on page 13 for more information.
8. —Click the triangle to pin the control bar to the screen, or auto-hide the bar when the cursor is moved.
   **Note** The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change your monitor color setting to 32-bit.
9. Video image.
10 Camera menu.
Right-click the image to open the menu and select an option. Options not supported by the camera are disabled (shown in gray). See the “Using the Pop-Up Menu” section on page 25 for more information.

11 Control icons.
- **Audio.** The audio icon appears if the camera supports audio. Click the icon to enable or mute live audio volume. This control does not affect recorded video.
- **PTZ.** Click to enable or disable the Pan, Tilt and Zoom (PTZ) controls. See the “Using Pan, Tilt, and Zoom (PTZ) Controls” section on page 32.
- **Note** The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change your monitor color setting to 32-bit.

**Additional Information**
Refer to the following topics for additional options:
- Using Record Now, page 24
- Using the Pop-Up Menu, page 25
- Using the Smooth Video Options When Viewing Live Video, page 27
- Synchronizing Video Playback in Multiple Panes, page 29
- Using Pan, Tilt, and Zoom (PTZ) Controls, page 32
Viewing Recorded Video

You can view recorded video from a continuous loop, for a motion event, or from a video clip. The camera must be configured to support each of these options, and you must have access to a video viewing application that supports these functions (some applications are used for viewing only).

For example, a camera can be configured to record the following:

- Continuous recordings that include video from a set amount of time, such as the past 60 minutes.
- Motion event recordings that are triggered whenever a motion event occurs. Video is recorded when the motion occurs, and for a configured number of seconds before and after the event. Use a video viewing application (such as the Cisco Video Surveillance Safety and Security Desktop) to view motion event video.

Tip

To control the playback in multiple video panes, press Shift-Click to select multiple concurrent panes, or Ctrl-Click to select individual panes. The borders of all selected panes turn to orange. Controls and actions performed in one pane also affect the other selected panes. To deselect panes, select a single pane, or use Shift-Click or Ctrl-Click to deselect the panes.

Usage Notes

- Multi-pane video clips can also be saved to your desktop and played using the Cisco Video Surveillance Review Player.
- If the Record Now feature is enabled, right-click the image and choose Record Now to record live video.
- If a camera is soft-deleted, you can still access the camera’s recorded video but cannot display live video. Recordings are retained on the system until removed according to the recording retention settings.
- Click the icon to toggle between live and recorded video. The icon appears when recorded video is displayed.
- The first time you select a camera’s recorded video, the playback begins slightly behind the live (current) time. When you toggle between live and recorded, recorded video returns to the previously selected timestamp.
Controlling Live and Recorded Video

Figure 6 describes the main recording features and controls.

**Figure 6**  
*Viewing Recorded Video*

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Camera Name—Source of the recorded video.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Indicates the video quality, which can be affected by network and system performance. The icon turns red if the video quality is poor.</td>
<td><strong>Note</strong> This icon is for informational purposes only when displayed with recorded video (the Smooth Video options do not apply).</td>
</tr>
<tr>
<td>3</td>
<td>Pop-up menu options. See the “Using the Pop-Up Menu” section on page 25.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Timestamp for the currently displayed video image. For example: <strong>7/12/2012 4:08:39:886 AM</strong>.</td>
<td><strong>Note</strong> Changes to <strong>Live</strong> when live video is displayed.</td>
</tr>
<tr>
<td>5</td>
<td>Range Bar—The span of video to work with.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The entire <em>range bar</em> represents the entire span of available recorded video. Slide the <em>range bar</em> selectors to shorten the range (see below).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The lower (green) <em>seek bar</em> represents the selected range (see below).</td>
<td></td>
</tr>
</tbody>
</table>
Range Bar selectors—Drag the *range bar* selectors to narrow the timespan of video you want to review. For example, drag the selectors to create a 10 minute range. You can then drag that range left or right to the appropriate place in the recorded span.

In the following example, the entire range of recorded video is selected (the *range bar* selectors are to the far right and left). To display the timestamps, click a selector.

Click and drag the *range bar* selectors to choose a shorter period of time. In the following example, the *range bar* selectors are used to select approximately 10 minutes of video. Drag the selected range left or right to locate the desired range of recorded video.

Tip The green *seek bar* represents the selected span. If the span in the top *range bar* is 10 minutes, then the green *seek bar* represents 10 minutes of video. Slide the *seek bar* selector to choose the playback time (see below).

Tip Double-click a *range bar* selector to playback the video from the beginning of that range.

Seek Bar —Represents the video range, and is used to select a playback time. For example, if the *range* is 10 minutes, then the *seek bar* represents 10 minutes of video.

Tip Right-click the *seek bar* and select **Seek to...** to select a specific date and time.

Note Gaps in the recorded video are shown in gray. Recording gaps occur if there is a manually-triggered Record Now session, if recording was manually stopped, if recording was stopped by a schedule, or if video was unavailable due to network connectivity issues, device malfunctions, or other events.

Seek Bar selector—Drag the selector to play video from the selected time (as indicated by the timestamp).

Note When you move the scroll bar for a video pane that is synchronized, that pane becomes the new synchronization master pane. The other synchronized panes play video according to the master pane. See the “Synchronizing Video Playback in Multiple Panes” section on page 29.
Bookmarks—Create bookmarks to save a video clip or a repeating segment (see below).

To create a bookmark, *Ctrl-Click-drag the seek bar*. The bookmark span is shown in orange.

Bookmarks menu—Right-click the *seek bar* to display the bookmark menu. You can save the bookmarked video as a clip in one of the supported formats, remove all bookmarks, or create a repeating segment.

See the following for more information:

- Creating, Viewing and Managing Video Clips, page 17
- Creating a Repeat Segment, page 23

Indicates live or recorded video. Click the icon to switch between live and recorded video.

- ![Live video icon](image)
  - Live video is displayed.
- ![Recorded video icon](image)
  - Recorded video is displayed.

**Tip** The first time you select a camera’s recorded video, the playback begins slightly behind the live (current) time. When you toggle between live and recorded, recorded video returns to the previously selected timestamp.

Recorded video playback controls.

- ![Step Reverse button](image)
  - (Archived video only) Pauses the playback and steps back one frame at a time.
- ![Play Reverse button](image)
  - (Archived video only) Plays the video archive in reverse at normal speed.
- ![Pause button](image)
  - Pauses the video playback.
- ![Play Forward button](image)
  - Play the video forward at normal speed.
- ![Step Forward button](image)
  - (Archived video only) Pauses the playback and steps forward one frame at a time.

**Variable Speed Playback**

Right-click the Play Reverse or Play Forward button to play the video slower or faster.

For example, select **0.50X** to play the video at half speed (forward or reverse). Select **4.00X** to play at 4 times the normal rate (forward or reverse).
### Controlling Live and Recorded Video

<table>
<thead>
<tr>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
</table>
| 13   | - Click the triangle to pin the control bar to the screen, or auto-hide it when the cursor is moved.  
     *Note* The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change your monitor color setting to 32-bit. |
| 14   | - Camera feature icons. For example:  
    - ![Audio Icon](image) or ![Audio Icon](image) — Audio is supported by the camera and enabled or disabled in the viewing pane.  
    - ![Synchronization Icon](image) — The synchronization icon appears in video panes that play synchronized video. See the “Synchronizing Video Playback in Multiple Panes” section on page 29.  
     *Note* The PTZ icons are enabled only for live video.  
     *Note* The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change your monitor color setting to 32-bit. |
Creating, Viewing and Managing Video Clips

Video clips can be created in multiple formats for playback using the Cisco VSM Review Player, or a third party player.

**Note**
Timestamps are not displayed in 3rd-party video viewers. Use the Cisco Review Player to display timestamps (see the Cisco Video Surveillance Review Player User Guide for more information).

This section includes the following topics:
- Supported File Formats, page 17
- MP4 Video Clip Usage Notes, page 18
- Creating Video Clips, page 18
- Viewing and Downloading MP4 Clips, page 21

Supported File Formats

Cisco Video Surveillance supports the creation and playback of the following video formats:

<table>
<thead>
<tr>
<th>File Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MP4</td>
<td>A standard video file format that is playable on most computers and useful for sending to 3rd parties. MP4 clips support a single video pane and can include audio (CVA/CVX files do not support audio). MP4 clips are saved on the server for 7 days and must be downloaded using the Select Streams and Clips menu or the Clip Search option.</td>
</tr>
<tr>
<td>CVA</td>
<td>Cisco video archives (CVA) can include multiple video panes that synchronize to the same time. CVA files can only be opened in applications that support the CVA format (such as the Cisco Review Player). CVA files do not support audio playback.</td>
</tr>
<tr>
<td>CVX</td>
<td>A tamper proof CVA file. CVX files require a password that is entered when the file is created. You must enter the password to open and view the video file. CVX video playback will shut down if the file is tampered with. CVX files do not support audio.</td>
</tr>
</tbody>
</table>

**Tip**
You can also right-click a video pane and select Take Snapshot to save a still image in BMP, JPEG, PNG, and TIFF formats. See the “Using the Pop-Up Menu” section on page 25 for more information.
MP4 Video Clip Usage Notes

MP4 clips are saved on the server. Review the following notes to manage the server-side clips.

Note

- CVA/CVX clips are downloaded immediately and not stored on the server.
- MP4 clips are automatically deleted after 7 days.
- MP4 clips require that the clipping repository be selected on the Media Server associated with the camera.
- If using the Operations Manager browser interface, you can also use Clip Search to view, download and delete MP4 clips saved to the server. See the “Clip Search (View, Download and Delete MP4 Clips)” section.
- You can create up to five MP4 clips at a time per Media Server.
- Users can only delete their own clips. Users that belong to a User Group with Camera permissions can also delete other users’ clips.
- If the clipping fails, see your system administrator for assistance.
- MP4 clips play automatically in the pane when downloaded. The clips can also be viewed using the Cisco VSM Review Player or VLC media player.

Creating Video Clips

To create video clips, create a bookmark span and select the file format, as described in the following procedure.

Requirements

- You must belong to a User Group with Export Recordings permissions to create, view or download video clips.
- The Media Server hard disk volume must have sufficient disk space to create the video clip or the operation will fail. See your system administrator for more information.

Procedure

Step 1
Select a video pane from the viewing application (such as Cisco SASD or Operations Manager).

Tip
To create a multi-pane clip in the CVA format, press Shift-Click to select multiple concurrent panes, or Ctrl-Click to select individual panes.

Step 2
In the green seek bar, Ctrl-Click and drag the mouse cursor to create a bookmark span. The bookmark span is shown in orange (Figure 7).

Tip
In recording mode , you can also right-click the image and choose Select Clip Range from the pop-up menu (see the “Using the Pop-Up Menu” section on page 25). A 10 minute clip range is automatically selected starting from current thumb position, and the range bar is automatically scaled to 1 hour.

Step 3
Right-click the bookmark and select an option to create a file in the desired format (Figure 7).
Step 4  Save the file:

CVA/CVX files

a. (Optional) Revise the start and end date and time (Figure 8). Enter a time between 30 seconds and 4 hours (the range cannot include more than one codec and the start time must be before the end time).

b. (Optional) Select **Enable tamper proof** and enter a password to create a password-protected CVX file.

c. Click **OK**.

d. Select a location on a local disk and click **Save**.

e. Wait for the clip to be generated and downloaded. Video streaming is paused during CVA/CVX clip generation.
MP4 clips

a. (Optional) Revise the start and end date and time (Figure 9). Enter a time between 30 seconds and 4 hours (the range cannot include more than one codec and the start time must be before the end time).

Figure 9 MP4 Clip Settings

b. (Optional) Enter a clip name that identifies the recording on the server (Figure 10). For example, if you enter “My 4500 Camera” then the clip selection will be “My 4500 Camera___1347005138141”. If blank, the default name is “My Clip__system-timestamp”.

c. (Optional) Select or deselect Record Audio (if the camera supports audio recordings) to include or exclude audio. Audio playback is supported only with the Cisco VSM Review Player or VLC media player.

d. Click OK to save the clip to the server.

Tip Right click the image and select Get clip status to view the current status: In-Progress, Completed or Failed. Use the Clip Search option to view, download, delete and manage MP4 clips saved on the server.

Step 5 Download and play the clip as described in the “Viewing and Downloading MP4 Clips” section on page 21.
Viewing and Downloading MP4 Clips

You can right-click a video pane and choose Select Streams and Clips to save and play MP4 clips. The clip remains on the server for 7 days after it was created.

Tip
If using the Operations Manager browser interface, you can also use Clip Search to view, download and delete MP4 clips saved to the server. See the “Clip Search (View, Download and Delete MP4 Clips)” section.

Note
See the “MP4 Video Clip Usage Notes” section on page 18 for more information.

Procedure

Step 1 Right-click the video pane and choose Select Streams and Clips (Figure 10).

Step 2 Select the Clip file.

Figure 10    Accessing a MP4 Clip

Note
Clips are automatically deleted from the server after 7 days.

Step 3 Enter a file name and location.

Step 4 Click Save and wait for the clip to download.

Step 5 The clip will automatically play in the pane the first time it is downloaded (Figure 11). To view the clips again, use a viewing application such as the Cisco Review Player.
Controlling Live and Recorded Video

Figure 11  MP4 Clip Viewing Pane

1. MP4 file name and location
2. Timestamp for currently displayed image.
Creating a Repeat Segment

A repeating segment is a range selected on a recording that plays continuously in a loop. When the end of the segment is reached, playback starts over from the beginning of the segment. The video segment loops indefinitely until you cancel the segment or seek video outside the selected range (seeking inside the selected range does not cancel the segment).

Procedure

1. **Ctrl-Click-drag** the seek bar in a recording to create a bookmark (Figure 12). The bookmark span is shown in orange.
2. Right-click the seek bar and select **as a repeat segment**.
3. (Optional) Enter a specific start and end date and time.
4. To cancel the segment, right-click the segment and choose **Remove all Bookmarks**. You can also click on the seek bar outside the selected range.

Note

Repeating segments are used with recordings only.
Controlling Live and Recorded Video

Using Record Now

To manually trigger recording of a live video stream, right-click the image and choose Record Now.

Requirements
- The Record Now option must be enabled for the camera configuration in the Operations Manager.
- Your use account must include access permissions to view recorded video.
- You can record video from the live primary video stream only.

Usage Notes
- Audio is not recorded.
- Video is recorded for a system-defined length of time (the default is 5 minutes).
- The recording is retained on the system according to the event retention settings for the camera. For example, if the camera’s event recordings are retained for 30 days, then the Record Now recordings will also be available for 30 days. When the retention time is exceeded, the recording is automatically deleted (see the “Creating, Viewing and Managing Video Clips” section on page 17 to save the video to a separate file).

Procedure

Step 1 Log in to the video viewing application and select a camera.
Step 2 Choose live video [ ] (see the “Viewing Live Video” section on page 9).
Step 3 Right click the image and choose Record Now (Figure 13).

- The recording is performed in the background. You can continue to use the other playback controls.
- The recording status is displayed in red text (Figure 13) when the recording time nearly complete.

Figure 13 Record Now
Step 4  To view the recorded video, review the following notes.

- Record Now clips are available from the primary stream only. Right click the image and choose **Select Streams and Clips** to view the recorded primary stream (disabled if the pane is synchronized).

- If the video is within the time span of other recorded video, there is no separate indication of the Record Now video. You can access the video as described in the “Viewing Recorded Video” section on page 12.

![Time span (for all recordings)](image)

**Record Now** recording included within the time span of other continuous and event recordings.

- If the Record Now video is older than the continuous loop, the gap between the recording times is shown in gray:

![Time span (for all recordings)](image)

**Record Now** recording  
**Recording gap**  
**Continuous loop** recording

**Note**  When the event retention time is exceeded, the Record Now recording is automatically deleted. To save the recording, see the “Creating, Viewing and Managing Video Clips” section on page 17.

---

### Using the Pop-Up Menu

Select a video pane and right-click on the image to open a menu with the following options (see Figure 5 on page 10).

<table>
<thead>
<tr>
<th>Table 3</th>
<th><strong>Camera Pop-Up Menu (Right-Click the Video Image)</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Camera Menu Item</strong></td>
<td><strong>Description</strong></td>
</tr>
</tbody>
</table>
| Pan, Tilt, and Zoom | (Live video only) Open the PTZ preset list that allows you to quickly adjust the camera view.  
See the “Using Pan, Tilt, and Zoom (PTZ) Controls” section on page 32 |
| Digital zoom | Digitally enlarges the image to zoom in on a specific area.  
Double click the enlarged image to use a window-in-window view. Adjust the viewing area in the small window to define the portion of enlarged video to display. |
Controlling Live and Recorded Video

### Table 3 Camera Pop-Up Menu (Right-Click the Video Image) (continued)

<table>
<thead>
<tr>
<th>Camera Menu Item</th>
<th>Description</th>
</tr>
</thead>
</table>
| Sync selected panes with this pane | Synchronizes the playback from multiple video panes to the same time.  
- After a pane is synchronized, the menu item changes to **Remove this pane from sync**.  
- To synchronize additional panes, right-click an un-synchronized pane and select **Add selected panes to sync**.  
See the “Synchronizing Video Playback in Multiple Panes” section on page 29. |
| Full screen mode              | Enlarges the video image to fill your display screen.  
**Tip** To exit, press Esc, or right-click and choose **Full screen mode** again.                                                      |
| Take snapshot                  | Saves a snapshot of a single video pane (excluding control icons, timestamps and other information) in BMP, JPEG, PNG, or TIFF format.     |
| Take composite snapshot        | Saves a snapshot of all panes in a multi-pane layout (including control icons, timestamps and other information) in BMP, JPEG, PNG, or TIFF format. |
| Record now                    | (Live video only) Immediately begins recording video.  
See the “Using Record Now” section on page 24 for more information.  
**Note** The Record Now option must be enabled in the camera configuration. |
| Audio settings                 | (Cameras with audio support only). Opens a window used to adjust video playback volume and balance.                                          |
| Smooth video settings          | (Live video only) Creates a smooth video playback if the playback is choppy or delayed due to network or other performance issues.  
See the “Using the Smooth Video Options When Viewing Live Video” section on page 27. |
| Global settings                | Provides settings that apply to all video panes. For example: **UI transparency** and **zoom video to fit the pane**.                             |
| Select Streams and Clips       | Allows you to select the live and recorded video streams (primary or secondary) supported by the camera.  
**Note** **Select Streams and Clips** is disabled when the pane is synchronized. See the “Synchronizing Video Playback in Multiple Panes” section on page 29 for more information. |
| Select clip range              | (Archive video only) Selects a 10 minute clip range starting from current thumb position. The range bar is automatically scaled to 1 hour.  
See the “Creating, Viewing and Managing Video Clips” section on page 17 for more information. |
| Get clip status                | Shows the current status of MP4 clips: In-Progress, Completed or Failed.                                                                     |
Understanding Video Pane Border Colors

The color that surrounds a video pane indicates the status of the video in that pane. For example, when you click anywhere in a video pane, the pane becomes active and the border changes to orange. The controls and actions performed apply to the active pane.

Table 4 describes the meaning of each color.

<table>
<thead>
<tr>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gray</td>
<td>The pane is not highlighted. All panes have a gray border by default.</td>
</tr>
<tr>
<td>Orange</td>
<td>The pane is selected as the active pane, and the controls and actions apply to that pane. If multiple panes are selected as active panes, the controls and actions performed on one pane apply to all active panes.</td>
</tr>
</tbody>
</table>

Using the Smooth Video Options When Viewing Live Video

If live video playback is choppy due to network or other performance issues, use the Smooth video settings to automatically do the following:

- Create a video data buffer (in seconds) that delays live playback while video data is cached. Live video can then be played back smoothly despite network delays between the camera, Media Server, and workstation.

- Automatically switch to a different stream if the live video quality is poor.

Icon Colors

The video quality icons in each pane indicate the following:

- Green indicates everything is fine.
- Yellow indicates that the client workstation has detected the playback is not smooth.
- Red indicates a severe adverse situation. Action will be taken to correct the situation, such as switching to secondary stream or iFrame streaming.

Usage Notes

- The Smooth Video Options are available only for live video on non-PTZ cameras (the Smooth Video Options are automatically disabled on PTZ cameras).

- The settings are applied to all non-PTZ cameras and are persistent for the current PC workstation. For example, the settings will remain if you log out and back in, or view a different camera and then return to the current camera.

- The settings also apply to the non-PTZ cameras when using the Cisco Safety and Security Desktop (SASD) application and the Cisco Video Surveillance Management Console.

- The Smooth Video options are disabled if you manually select a stream (right-click a video pane and choose Select Streams and Clips). The pane will display the selected stream even if the video quality is poor (the video will not automatically switch to the Smooth Video alternative stream). To cancel the manually selected stream and re-enable the Smooth Video settings, reload the view or drag and drop the camera again.

- If a video stream is selected from a redundant media server, the Smooth Video option is disabled (the camera will not use a secondary stream even if the video quality icon is red).
Controlling Live and Recorded Video

Procedure

Step 1
Right-click a live video image to open the pop-up menu.

Step 2
Select or deselect **Enable Smooth Video for Live non-PTZ Camera** to enable the smooth video options.

Step 3
(Optional) Enter the **Preroll Buffer Size in Seconds** to define the number of seconds that live video will be delayed.

Video data is saved in a cache on your PC to avoid pauses caused by network bandwidth and other issues. We recommend a value between 1.5 and 3 seconds.

Caution

We strongly recommend that the **Preroll Buffer** be disabled (enter 0 or leave the field blank) since streaming delays can cause a potential security risk. We recommend that you address the network bandwidth or performance issues causing the delays. Use the **Preroll Buffer** only when significant stuttering occurs and a network resolution is not available.

Step 4
Use the **Smooth Video Options** to define an alternative video stream that will be used if video quality is poor despite the smooth video buffer (video quality is indicated by the icon on the live viewing pane).

- **Secondary Stream**—(Only if configured on the camera) If the live video quality is poor, the secondary video stream is used. Secondary streams typically present a lower-quality image that requires less bandwidth and processing.

- **I frame only**—If the live video quality is poor, then only the iFrame video is displayed. iFrame video reduces the bandwidth requirement to correct the situation.

- **None**—If the live video quality is poor, no change is made and the selected stream is displayed even if it results in choppy or paused playback.

Note

- These options are not used if the video quality is **acceptable** or if the icon is yellow (**intermediate**). The selected stream is displayed normally.

- A down arrow is displayed when the secondary or iFrame stream is applied.

- If an alternative stream is applied, the settings remain until you close and reopen the video source (camera).
Synchronizing Video Playback in Multiple Panes

To synchronize video playback from multiple panes, select multiple panes, right-click the pane that defines the master time, and choose **Sync Selected Panes With This Pane**. All panes will play video from the same date and time.

**Usage Notes**

- All panes will play forward when synchronization begins, even if one or more of the panes was playing in reverse.
- Synchronization for recorded video is performed only if the time in the selected panes overlap. If the time for a video pane does not overlap with the master pane, the pane is excluded from synchronization.
- When you move the scroll bar for a video pane that is synchronized, that pane becomes the new synchronization master pane. The other synchronized panes play video according to the new master pane.
- If the seek controls are used to search video, the other synchronized panes pause until the seek completes, then continue to display video that is synchronized with the new master pane time.
- You can switch the synchronized panes between live and recorded video.
- To remove a pane from the synchronized playback, right-click the pane and choose **Remove This Pane From Sync** to remove it.
- To add un-synchronized panes, right-click the pane and choose **Add selected panes to sync**.
- The **Select Streams and Clips** menu item is disabled when a pane is synchronized.
- When 16 video panes are synchronized, some live video panes may appear to be not synchronized if the video stream is configured for the following:

<table>
<thead>
<tr>
<th>Format</th>
<th>Resolution</th>
<th>Framerate</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG</td>
<td>640x480</td>
<td>30 fps</td>
</tr>
<tr>
<td>H-264</td>
<td>1920x1080</td>
<td>30 fps</td>
</tr>
</tbody>
</table>
Figure 14 describes the main synchronization attributes.

**Figure 14  Synchronized Playback of Recorded Video**

1. The synchronization icon appears in the video panes that display synchronized video.
2. The timestamp for synchronized video is the same.
3. Roll over a synchronized pane to display the playback controls. Changes to any pane are mirrored by the other panes.
4. Unsynchronized panes can continue to display live or recorded video.

To add a pane to the synchronized group, right-click the pane and select **Add selected panes to sync**.

**Procedure**

To play recorded video from multiple video panes synchronized to the same time, do the following:

**Step 1**  Select a layout or pre-defined view from the **View** menu.

**Step 2**  **Shift-click** or **Control-click** to select multiple video panes for synchronization.

The selected panes are displayed with a light yellow border.
Step 3  Right-click a video pane and select **Sync Selected Panes With This Pane** from the menu.
The selected pane becomes the master pane.

Step 4  (Optional) To remove a pane from the synchronized group, right-click the pane and choose **Remove This Pane From Sync**.

**Note**  The pane continues to play video from the same timestamp, but the video can be stopped or altered without affecting the other panes.

Step 5  (Optional) To add un-synchronized panes, right-click the pane and choose **Add selected panes to sync**.
Using Pan, Tilt, and Zoom (PTZ) Controls

Cameras that support pan, tilt and zoom (PTZ) movements display a PTZ icon.

- To pan and tilt, left-click the image (the movement icons appear) and drag the mouse right, left, up and down.
- To zoom, hold down the left mouse button and use the scroll wheel to zoom in and out.

**Tip**

To use a USB joystick, see the “Calibrating a Joystick for Windows 7” section on page 34.

In addition, PTZ presets allow the camera to quickly jump to a preset position. For example, a PTZ preset could zoom in on a doorway, or pan to the opposite end of a parking lot. PTZ presets can be triggered using a mouse, joystick or automatically triggered event.

**Note**

Cameras can also be configured with PTZ tours that automatically cycle between PTZ preset positions. You can interrupt the tour using the PTZ controls, and the tour will resume after a set amount of time. See your system administrator for more information.

*Figure 15* summarizes the controls and information available on each PTZ camera viewing pane.

---

**Figure 15**  
Camera PTZ Controls

1. Selected Camera  
2. PTZ is available in Live mode only  
3. PTZ Enabled/Disabled Icon (click to toggle)  
4. PTZ Preset Menu (right-click to access)

**Usage Notes**

- PTZ movements are available only when viewing live video.
Controlling Live and Recorded Video

- PTZ can only be enabled for a single video pane if multiple panes are displayed. See the “Using PTZ Controls When Multiple Video Windows are Displayed” section on page 35.
- You must also belong to a user group with Perform PTZ permissions.
- PTZ commands are available only if the primary Media Server is functional. If the Primary server goes down, or is not available on the network, PTZ commands will not function even if video is still being delivered by a redundant server (if configured).

Procedure
To control a camera’s PTZ movement or trigger a PTZ preset position, do the following:

---

**Step 1** Display the live video from a PTZ-enabled camera:

a. Click Monitor Video.

b. Expand the location tree and select the camera.

c. Highlight a video pane and double-click a camera name.

**Step 2** Verify that the PTZ controls are enabled:

- PTZ controls are supported by the camera and enabled in the viewing pane.
- PTZ controls are disabled. Click the icon to enable PTZ controls.

Note  If a higher-priority user is using the PTZ controls, the PTZ controls remain locked and you cannot control the PTZ movements until released by the higher priority user.

**Step 3** To move the camera position, use the following controls.

**Using a Mouse**
- Pan and Tilt—Left-click the image and drag the mouse ( ) right, left, up and down.
- Zoom—Hold down the left mouse button and use the scroll wheel to zoom in and out.

**Using a USB Joystick**
- Pan—move the joystick bar horizontally.
- Tilt—move the joystick bar vertically.
- Zoom—twist the joystick.

Tip  See the “Calibrating a Joystick for Windows 7” section on page 34 for information to set up a USB joystick for the first time.

**Step 4** (Optional) Select a PTZ preset position.

**Using a Mouse**
- Right-click the image and choose Pan, Tilt, and Zoom and then Presets (Figure 15).
- Choose a preset to move the camera to the defined position.

**Using a USB Joystick**
- Press the joystick button that corresponds to the PTZ preset number.
For example, joystick button 1 triggers PTZ preset 1, joystick button 2 triggers PTZ preset 2, etc.

---

**Calibrating a Joystick for Windows 7**

To use a USB joystick to control PTZ camera movements, connect the joystick to a USB port on the client PC and calibrate the device for Window 7. You can use the software and instructions included with the joystick, or use the built-in Windows calibration utility, as described in the following procedure.

**Procedure**

**Step 1** Install and configure the USB joystick according to the manufacturer instructions.
- See the device documentation for more information.
- The manufacturer may also include a calibration utility that can be used instead of the built-in Windows utility.

**Step 2** In Windows 7, calibrate the device using the *Game Controllers* control panel.
   a. Select *Control Panel* from the *Start* menu.
   b. Select *Hardware and Sound*.
   c. Select *Devices and Printers*.
   d. Double-click *Game Controllers*.
   e. Highlight the joystick device and click *Properties*.
   f. Click *Calibrate* in the pop-up window.
   g. Follow the on-screen instructions to complete the process.

**Tip** You can also use the Windows search function: choose *Search* from the *Start* menu and enter “*set up USB game controllers*” to open the *Game Controllers* control panel. Highlight the joystick icon and click *Calibrate*. Follow the on-screen instructions to complete the process.

**Step 3** Click *Finish* or *OK* to close the windows.
Using PTZ Controls When Multiple Video Windows are Displayed

When multiple viewing panes are displayed, only a single pane can have PTZ controls enabled at a time (Figure 16). This prevents a USB joystick from affecting more than one pane.

- The pane with PTZ enabled displays a 🎥 icon. The 🎥 icon indicates that PTZ controls are disabled.
- Click the disabled icon 🎥 to enable the controls for a pane (and disable the controls for the other panes).
- If a pane does not display an icon, then the camera does not support PTZ movements.

**Figure 16 PTZ Controls in a Multi-Pane View**

<table>
<thead>
<tr>
<th></th>
<th>PTZ enabled viewing pane</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>PTZ disabled viewing pane</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>PTZ not supported by camera (no icon)</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

PTZ movements are available only when viewing live video.

**Tip**

If multiple browser windows are used to display video, joystick PTZ commands will affect the enabled PTZ pane in each browser window.
Clip Search (View, Download and Delete MP4 Clips)

Select Clip Search from the Monitor Video window (Figure 17) to view, download and delete MP4 clips saved to the server.

**Tip**
You can also create and download clips by right-clicking a video pane. See the “Viewing and Downloading MP4 Clips” section on page 21.

**Note**
Review the “MP4 Video Clip Usage Notes” section on page 18 before you begin.

**Procedure**

**Step 1** From the Monitor Video page, click Clip Search to open the Clip Search window (Figure 17).

---

**Figure 17** Clip Search Window
Step 2  (Optional) Use the filters to search for specific clips (Table 5):

Tip  Click Search without filters to display all available clips.

### Table 5  Filters For Searching Clips

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>By Clip Name</td>
<td>The full or partial name for the clip(s), which is entered when the clip is created</td>
</tr>
<tr>
<td>By Tag</td>
<td>Not available in Release 7.2.</td>
</tr>
<tr>
<td>By Clip Status</td>
<td>Select the status for the displayed clips. Any status not selected will not be displayed.</td>
</tr>
<tr>
<td>By Clip Owner</td>
<td>Select Owned by me to display only clips you created De-select to display clips created by other users.</td>
</tr>
<tr>
<td>By Camera</td>
<td>The camera name where the clip originated.</td>
</tr>
<tr>
<td>By Location</td>
<td>Clips created by all cameras at the selected location(s).</td>
</tr>
<tr>
<td>By Server</td>
<td>Clips created by all cameras associated with the selected servers(s).</td>
</tr>
</tbody>
</table>

Step 3  Click Search.

Step 4  Review information about the clips.

### Table 6  Video Clip Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip Name</td>
<td>The clip name entered when the clip was created. The default is “My Clip” if no name is entered.</td>
</tr>
<tr>
<td>Camera Name</td>
<td>The camera name where the clip originated.</td>
</tr>
<tr>
<td>Start Time</td>
<td>The start timestamp for the clip.</td>
</tr>
<tr>
<td>End Time</td>
<td>The end timestamp for the clip.</td>
</tr>
<tr>
<td>Clip Expiration</td>
<td>The date/time when the clip will be deleted from the server.</td>
</tr>
<tr>
<td>Clip Status</td>
<td>In-Progress, Completed or Failed</td>
</tr>
<tr>
<td>Location</td>
<td>Location of the cameras where the clip originated.</td>
</tr>
<tr>
<td>Media Server</td>
<td>The Media Server that manages the camera video where the clip originated.</td>
</tr>
<tr>
<td>Clip Owner</td>
<td>The user that created the clip.</td>
</tr>
<tr>
<td>Tags</td>
<td>Tags associated with the clip (blank in Release 7.2)</td>
</tr>
</tbody>
</table>

Step 5  (Optional) To download a clip, select a clip and click Download.

Note  Only a single clip can be downloaded at a time.
Note If an “HTTP 400 Bad Request” error appears, it may be due to the Internet Explorer (IE) settings. In IE, go to Tools > Internet Options > Advanced and select “Use HTTP 1.1”. Also deselect “Use HTTP 1.1 through proxy connections”. Next, click the Connections tab, choose the LAN settings button and select “Automatically detect settings”.

a. Click Continue and accept the security certificate when the Internet Explorer web browser prompts you to proceed to the secure page. This prompt appears only once for each Media Server.
b. Select one of the following options:
   - Open—Plays the file using your default video player.
   - Save—Saves the file to the default location using a default filename.
   - Save As—Enter a new filename and select a location on the local disk.
   - Save and Open—Saves the file to the default location using a default filename, and then plays the clip using your default video player.

Step 6 (Optional) To permanently delete a clip from the server, select one or more clips and click Delete.

Note Only the server file is deleted. Any clips previously downloaded to a local disk are not affected.
Viewing a Thumbnail Summary of Video Archives

Use Thumbnail Search to quickly locate specific scenes or events in recorded video. Thumbnails are an alternative way to search through recorded video without fast-forwarding or rewinding. Figure 18 provides an overview of the search and display controls. See the “Using Thumbnail Search” section on page 41 for step-by-step instructions.

**Figure 18** Thumbnail Window

1. **Selected Camera**
   - Select a location and double-click a camera name to display a thumbnail summary of recorded video for the camera.
   - Use the Recordings menu to select a camera stream.
   - Cameras are displayed as tabs along the top of the window. Double-click multiple cameras to open a tab for each camera.
   - Double-click an archive to play video in an Archive Player tab.

2. **Skip back**
   - Skip back by the Duration time increment (see #7). This icon is disabled if the entire archive is selected.

3. **Archive start time**
   - The start date and time for the entire video archive.
   - See #4 to select a new start time, or right-click a thumbnail and choose Set Start.
### Viewing a Thumbnail Summary of Video Archives

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| **4** | **Set Start Time** | The start date and time for the first thumbnail (in the top left corner of the window pane). To change the start thumbnail, select a new date and time and click **Set Start**.  
**Tip** You can also select a thumbnail image and select **Actions > Set Start** to set the start time to a specific thumbnail (or right-click the thumbnail image and select **Set Start**). |
| **5** | **Timeline** | Timeline representing the entire video archive. |
| **6** | **Start time slider** | The slider represents the Duration setting relative to the length of the entire archive. If the Duration setting is for the entire archive, the black slider covers the entire time line and cannot be moved.  
To use the slider, choose a **Duration** that is less than the entire archive time and drag the slider to a different start time (the time is displayed above the slider). Release the mouse button to choose the new time. |
| **7** | **Duration** | Choose the time span for the displayed thumbnails. The top left thumbnail displays an image from the beginning of the time span and the bottom left thumbnail displays an image from the end of the time span. The number of thumbnails and the intervals between them depend on the size of the Forensic Search window and the thumbnail size that you choose from the **Thumbnail Size** menu. |
| **8** | **Show Timestamp** | Check this check box to show the date and time displayed at the top of each thumbnail. |
| **9** | **Archive end time** | End date and time for the entire video archive. |
| **10** | **Skip forward** | Skip forward by the **Duration** time increment. |
| **11** | **Timestamp** | Displays the date and time for each thumbnail. Select the **Show Timestamp** check box to turn timestamps on or off. |
| **12** | **Video thumbnails** | Thumbnails are displayed for the time span that is selected in the Duration drop-down menu. Use the **Thumbnail Size** menu to display larger or smaller thumbnails. |
| **13** | **Actions Menu** | Right click a thumbnail to select an option from the Actions menu (see **#17**). |
| **14** | **Display length** | The duration of the displayed thumbnails. |
| **15** | **Camera tabs** | A tab is displayed for each selected camera. Click the **Recordings** menu to select an available camera stream or recording. |
| **16** | **Archive Player tab** | An Archive Player tab plays video when you select a thumbnail and select **Actions > Play** (or right-click a thumbnail and click **Play**). |
Viewing a Thumbnail Summary of Video Archives

Summary Steps
To view a thumbnail summary of a camera’s recordings:

1. Select Monitor and click Thumbnail Search to open the forensic search tool in a separate window (Figure 18).
2. Select a location and double-click a camera name.
3. Use the tools described in Figure 18 to locate specific video.
4. Select a different stream from the Recordings menu.
5. Double-click a thumbnail to play the video. You can also select a thumbnail and select Play from the Actions menu.
6. See the “Detailed Procedure” for more information.

Using Thumbnail Search

Menu Selections

<table>
<thead>
<tr>
<th>17</th>
<th>Menu Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Thumbnail Size</strong>—select a smaller size to display more thumbnails for the displayed video duration. Select a larger size to display fewer thumbnails.</td>
</tr>
<tr>
<td></td>
<td><strong>Recordings</strong>—select a video stream or recording.</td>
</tr>
<tr>
<td></td>
<td><strong>Actions</strong>—choose one of the following options:</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> You can also right-click a thumbnail to access the Actions (see #13).</td>
</tr>
</tbody>
</table>

- **Set Start**—Sets the selected thumbnail as the first thumbnail in the range. (Tip: to select a specific date and time as the start time, use the menu at that appears beneath the thumbnails as described in #4 “Thumbnail Start Time”).
- **Play**—Plays the video from the selected thumbnail in an Archive Player tab.
  - You can also double-click a thumbnail to play video.
  - Playback begins from the start timestamp. If a start timestamp is not available, the next available frame is displayed.
- **Zoom To**—Set the beginning and ending thumbnail for the display. Shift-click or Ctrl-click to select multiple thumbnails and choose Zoom To from the Actions menu. The first frame in the selected thumbnails becomes the new start time. The last frame in the selected thumbnails becomes the new end time.
- **Zoom In**—Decreases the displayed thumbnail duration to the next available duration value. If no frames are selected, the start time does not change. If one frame is selected, that frame becomes the start time. If more than one frame is selected the frame closest to the beginning of the archive becomes the start time.
  - Zoom in is not available when the minimum duration is set.
- **Zoom Out**—Increases the duration of the displayed thumbnail duration to the next available duration value. The start time remains the same. For example, if the Duration is 3 hours, choose the Zoom Out option to increase the Duration to approximately 6 hours.
  - If the start time plus the duration would exceed the length of the archive, the start time will be adjusted to the archive’s end time minus the duration.
  - Zoom out is not available when the maximum duration is set.
**Detailed Procedure**

**Step 1** Click **Monitor**.

**Step 2** Click **Thumbnail Search** to open the forensic search window (Figure 18).

**Step 3** Select a location and double-click a camera name.

The camera name appears as a tab at the top of the thumbnail display. You can select multiple cameras to open multiple tabs.

**Step 4** Use the controls described in Figure 18 to refine the search.

For example:

- To change the first thumbnail in the display, select a date and time from the menu below the thumbnails and click **Set Start**. The thumbnail for the selected date and time is displayed in the top left corner (you can also right-click a thumbnail and choose **Set Start**).
- Choose the **Duration** of the thumbnail display. For example, choose **1 Hour** to display thumbnails for a single hour. The default is **Entire Archive**.
- Click the skip icons to skip back or forward by the **Duration** time. For example, if the **Duration** is 1 hour, click the skip buttons to skip forward or back by 1 hour.

- Click and drag the slider to a new start time.
  - The slider date and time appears when the slider is selected.
  - Release the mouse button to refresh the thumbnail display with the time displayed above the slider.

  **Note** The slider length represents the thumbnail duration relative to the entire length of the archive. The gray time line equals 100 percent of the archive. The black slider covers the entire time line if the selected Duration is Entire Archive (default).

- Choose a **Thumbnail Size** to enlarge or reduce the size of each thumbnail. Larger sizes display fewer thumbnails, and each thumbnail represents a greater time span.

**Step 5** (Optional) Further refine your search by choosing one or more thumbnails and choosing one of the following options in the **Actions** menu.

**Tip** You can also right-click a thumbnail to access the **Actions**.

- **Set Start**—Sets the selected thumbnail as the first thumbnail in the range (you can also select a specific date and time using the Set Start menu below the thumbnail display).
- **Play**—Plays the selected thumbnail video in an Archive Player tab.
  - You can also double-click a thumbnail to play video.
  - Playback begins from the start timestamp. If a start timestamp is not available, the next available frame is displayed.
• **Zoom To**—Set the beginning and ending thumbnail for the display. Shift-click or Ctrl-click to select multiple thumbnails and choose **Zoom To** from the Actions menu. The first frame in the selected thumbnails becomes the new start time. The last frame in the selected thumbnails becomes the new end time.

• **Zoom In**—Decreases the displayed thumbnail duration to the next available duration value. If no frames are selected, the start time does not change. If one frame is selected, that frame becomes the start time. If more than one frame is selected the frame closest to the beginning of the archive becomes the start time. **Zoom In** is not available when the minimum duration is set.

• **Zoom Out**—Increases the duration of the displayed thumbnail duration to the next available duration value. The start time remains the same. For example, if the Duration is 3 hours, choose the **Zoom Out** option to increase the Duration to approximately 6 hours.

  If the start time plus the duration would exceed the length of the archive, the start time is be set to the end of the archive minus the duration.

  **Zoom out** is not available when the maximum duration is set.
Understanding the Additional Video Viewing Options

Although this document describes how to monitor live and recorded video using the browser-based Cisco Video Surveillance Operations Manager, you can also use additional Cisco-provided applications or a third-party application that supports ActiveX controls, as described in Table 7.

Table 7  Summary of Cisco Video Viewing Options

<table>
<thead>
<tr>
<th>Viewing Tool</th>
<th>Application</th>
<th>Description</th>
<th>Additional Documentation</th>
</tr>
</thead>
</table>
| Web-based configuration and monitoring tool | Cisco Video Surveillance Operations Manager (Operations Manager) | • Allows simultaneous viewing of multiple video panes:  
  - View up to 4 cameras with the 32-bit version of Internet Explorer.  
  - View up to 16 cameras with the 64-bit version of Internet Explorer.  
  • Create the Views and Video Walls available in the desktop Cisco SASD application.  
  • Configure the camera, streams and recording schedules. | Cisco Video Surveillance Operations Manager User Guide |
| Desktop monitoring application    | Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) | • Allows simultaneous viewing of up to 16 cameras.  
  • Create Video Matrix windows for display in separate monitors.  
  • View Video Walls.  
  • Create unattended workstations.  
  • View and manage alerts.  
  • View cameras, video, and alerts based on a graphical map. | Cisco Video Surveillance Safety and Security Desktop User Guide  
Tip  
Go to Operations > Software to download and install the application. |
| Desktop video clip player         | Cisco Video Surveillance Review Player (Cisco Review Player) | Simple player used to view video clip files. | Cisco Video Surveillance Review Player  
Tip  
Go to Operations > Software to download and install the application. |
| Web-based server console          | Cisco Video Surveillance Management Console (Cisco VSM Management Console) | Provides basic viewing features for a single stream (Stream A) from a single camera. | Cisco Video Surveillance Management Console Administration Guide |
Related Documentation

See the Cisco Video Surveillance 7 Documentation Roadmap for descriptions and links to Cisco Video Surveillance documentation, server and storage platform documentation, and other related documentation.